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ABSTRACT

Internet connectivity in schools is critical to provide students with the digital literary skills neces-
sary to compete in modern economies. In order for governments to effectively implement digital
infrastructure development in schools, accurate internet connectivity information is required. How-
ever, traditional survey-based methods can exceed the financial and capacity limits of governments.
Open-source Earth Observation (EO) datasets have unlocked our ability to observe and understand
socio-economic conditions on Earth from space, and in combination with Machine Learning (ML),
can provide the tools to circumvent costly ground-based survey methods to support infrastructure
development. In this paper, we present our work on school internet connectivity prediction using
EO and ML. We detail the creation of our multi-modal, freely-available satellite imagery and survey
information dataset, leverage the latest geographically-aware location encoders, and introduce the
first results of using the new European Space Agency ϕ-lab geographically-aware foundational model
to predict internet connectivity in Botswana and Rwanda. We find that ML with EO and ground-based
auxiliary data yields the best performance in both countries, for accuracy, F1 score, and False Positive
rates, and highlight the challenges of internet connectivity prediction from space with a case study in
Kigali, Rwanda. Our work showcases a practical approach to support data-driven digital infrastructure
development in low-resource settings, leveraging freely available information, and provide cleaned
and labelled datasets for future studies to the community through a unique collaboration between
UNICEF and the European Space Agency ϕ-lab.

1 Introduction

In December 2020, the United Nations Children’s Fund (UNICEF) and the International Telecommunication Union
(ITU) reported that two-thirds (or 1.3 billion) of the world’s school-age children do not have an internet connection
in their homes [UNICEF Europe and Central Asia, 2020]. To combat this, the Giga initiative was created, aiming to
connect every school to the internet and every young person to information, opportunity and choice [UNICEF, 2023a].
Worldwide, schools provide critical online learning infrastructure to communities, and the digital divide between
lower-income countries and more developed nations exacerbates already existing inequalities, causing children to
fall even further behind. Our work targets the United Nations’ Sustainable Development Goal (SDG) 4 of Quality
Education: Ensuring inclusive and equitable quality education and promote lifelong learning opportunities for all.
The digital divide refers to the disparity between countries, regions, and people and their access to digital services
[Van Dijk, 2019]. In 2023, 60% of the African population is unconnected to the global digital society [Internet World
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Stats, 2023], and in the United Nations-designated least developed countries, less than 30% of the population uses
the Internet, according to a 2021 estimate [ITU, 2021]. Digital access, information and communication are key to
a country’s development, and this gross disparity is considered a global challenge [Bon et al., 2024]. Traditionally,
policymakers rely on prohibitively costly and timely surveys to capture the data required for a clear understanding of a
country’s digital infrastructure. Earth Observation can provide governments and stakeholders an affordable, objective
alternative to support infrastructure and sustainable development programs. EO is the process of gathering information
about the physical, chemical, and biological systems of the planet via remote-sensing [ESA, 2020]. Open-source,
satellite-based measurements have traditionally been under-utilized in low-income contexts, where such data can
provide great benefits [Yu, 2014, Haack and Ryerson, 2016]. EO data is particularly powerful in data-scarce developing
countries, complementing other sources of data such as censuses and ground teams [Caribou Space, 2020]. Large
volumes of EO data are now easily accessible and can provide unparalleled information about Earth systems and society,
creating the opportunity to leverage Machine Learning to reveal patterns and insights across multiple domains [Debien
et al., 2021]. It is not, however, practical to assume that high-resolution, pre-processed data can be seamlessly obtained
and utilized. A key motivation and contribution of our work is the utilization of free, globally-available data sources, for
which we have created a labelled dataset for future studies for the broader community.

Within Artificial Intelligence the (AI) for EO communities, there has been an increased focus on developing geographi-
cally aware AI models. These models come in various forms, but shared amongst them is that they, given images or
locations, provide embeddings that summarize the characteristics of a given area. These embeddings offer convenient
usage in diverse downstream tasks [Klemmer et al., 2023]. The embeddings are directly helpful for classification
and clustering, and the models can be fine-tuned with new prediction heads to provide end-to-end workflows. These
vector embeddings, referred to as feature embeddings throughout this work, have performed well in various predictive
tasks, ranging from multi-class classification to image recognition and generalizing geographically. By pre-training
models with global data and location information, the aim is to make the models robust towards variance in geography,
providing improved generalizability across geographical domains. Geographic generalization is a critical component of
the adoption of these AI methodologies in developing countries, where often economic disparities between developing
nations and the Global North result in critical infrastructure gaps in training data availability, resulting in models trained
on datasets well representing Europe and North America, and failing in contexts within the Global South.

We present work on ML-powered school internet connectivity prediction leveraging EO data, to support data-driven
infrastructure development in digitally-underserved communities. Contributing to the AI for EO community, we show
our results of hand-crafted engineered feature spaces using a combination of fully open-source EO and survey data
compared to and in combination with the use of geographical-aware location encoder-extracted feature embeddings as
inputs to our ML classifiers, and introduce a new geographical AI Foundation model. We demonstrate our model’s
performance in two pilot countries, Botswana and Rwanda. To provide digestible and interpretable outputs for
stakeholders, we highlight feature importance metrics for connectivity prediction and provide intuitive model outputs in
the form of maps to easily visualize where and who needs support. In the context of this work, we refer to connectivity
as the usage of Internet by an entity (school), with no boundaries on performance (i.e. upload or download speeds).

2 Related Work

Machine Learning for Social Good with Earth Observation: Over the past decade, the theme of AI for Social
Good has grown rapidly, whereby researchers aim at developing AI methods and tools to address problems at the
societal level and improve the well-being of the society [Shi et al., 2020]. Inferring socio-economic indicators with ML
and space-based datasets has been investigated, with numerous works focused on poverty mapping [Tingzon et al.,
2019, Pettersson et al., 2023, Yeh et al., 2020]. Mapping infrastructure with EO and ML is another popular area of
research, with studies focused on identifying informal settlements, slums, and deprived areas in [Fallatah et al., 2020,
Wurm et al., 2019, Wang et al., 2019, Fisher et al., 2022], but there has been relatively little attention in the domain of
connectivity mapping. The World Bank has created an openly-available composite map of the global power system
with ML [Arderne et al., 2020], and there has been published work on policy evaluation in data-sparse environments
to assess the livelihood impact of electricity access in Uganda using satellite imagery and ML [atledge et al., 2022],
but there have been no studies focused on internet connectivity mapping. Our work builds on the previous work of
socio-economic infrastructure mapping to provide an analysis of the feasability and limitations of ML for estimating
internet connectivity in schools with freely-available satellite data, and tests the capability of global, general-purpose
location embeddings from CLIP-based models to support our use case.

Geographically-Aware Neural Networks: Incorporating spatial context within AI models using satellite imagery
can improve model generalization and overall performance, and growing interest in developing geographically-aware
embeddings from geospatial datasets has been explored in the development of the Satellite Contrastive Location-Image
Pretraining (SatCLIP), GeoCLIP, Contrastive Spatial Pre-Training (CSP), and GPS2Vec models [Klemmer et al., 2023,
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Vivanco Cepeda et al., 2023, Mai et al., 2023, Yin et al., 2019]. SatCLIP, GeoCLIP and CSP all utilize the concept
of Contrastive Language-Image Pretraining (CLIP), whereby models are trained on a variety of (image, text) pairs
[Radford et al., 2021b]. CLIP is an efficient method of image representation learning from natural language supervision.
This concept is extended to incorporating geographic context with EO data in these models, whereby instead of
training text and image encoders, a geographically-aware location encoder is trained to learn implicit representations
of locations from satellite imagery. SatCLIP in particular has previously showcased its ability to perform well on a
variety of downstream tasks utilizing open-source satellite imagery, including Median Income, California Housing
Prices and logged Population Density [Jia and Benson, 2020, Pace and Barry, 1997, E et al., 2021]. Our work leverages
the SatCLIP, GeoCLIP and CSP location encoders for a comparative analysis of suitability for internet connectivity
prediction in schools.

3 Data

3.1 Engineered Features

Satellite Imagery Features: We derived a rich set of tabularized features from publicly available mid-resolution satellite
data from Google Earth Engine (GEE). Taking each location with connectivity information in our dataset as the center
point, we extract a 1,000m radius extent of satellite data from GEE including MODIS landcover, VIIRS Nightlight,
Global Human Modification, Gridded Population of the World, and Global Human Settlement Layer data products
using the airPy1 data processing package Sulla-Menashe and Friedl [2023], Elvidge et al. [2017], Kennedy et al. [2019],
CIESIN [2018], M. and Panagiotis [2023], which represents the land use and extent of urbanization surrounding the
schools. We relate our work to poverty mapping, with the assumption that regions suffering from greater levels of
poverty are less developed and therefore less likely to have internet access. Land-use data has been used in previous
poverty mapping studies by [Tian et al., 2022] which highlighted the relationship between cropland ratio and poverty
mapping, and nighttime light intensity and building distribution data has been used by [Putri et al., 2023] with ML for
poverty mapping in East Java, Indonesia, providing support for our data selection choices. Table 1 summarizes the
engineered feature space. We selected the geospatial buffer extent for feature creation by first performing a comparative
analysis of ML classifier connectivity prediction performance using only geospatial features for 300m, 500m, 750m,
1,000m, and 5,000m buffers extents and found that 1,000m yielded the best results for test set F1 score and accuracy.
Further details on feature generation, datasets, and buffer selection are found in Supplementary Materials.

Table 1: School connectivity geospatial feature space.

Source Resolution Metrics

MODIS Land cover 500m % coverage per class, mode, variance
Gridded Population of the World 927.67m mean, variance, max, min
VIIRS Nightlight 463.83m max, min, mean, variance
Global Human Settlement Layer 10m % coverage per class, mode, variance
Global Human Modification 1000m mode, variance, mean, max, min
World Bank Electrical Power Grid - distance from school to nearest transmission line

Ookla Speedtest -
average download, upload and latency for mobile and fixed tests,
no. of mobile and fixed tests per tile,
distance of nearest tile to school, no. of unique mobile and fixed devices

Ground-based Infrastructure Features: To integrate power grid information, the distance from each school to the
nearest transmission line is calculated and added as a feature using electrical power grid information from the World
Bank Group [Arderne et al., 2020]. To incorporate mobile and fixed device speed test data, we calculate the distance of
each school to the nearest mobile and fixed broadband Ookla tile and include relevant information about download and
upload speeds from devices recorded in that tile, with data provided by the Ookla for good initiative from October 2023
[Ookla LLC., 2023].

Data Pre-processing: We perform min-max scaling of the feature space to improve performance as implemented in
scikit-learn. Using the pearson standard correlation coefficient, we compute the pairwise correlation of feature columns
and remove those with a score of greater than 0.9.

Labels: Location and connectivity status information per institution is provided from government partners through
Project Connect, which provides the longitude, latitude and binary connectivity label for each school in the dataset

1
https:/github.com/kelsdoerksen/airPy
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Figure 1: From left to right, Top: 3 connected schools in Rwanda, 2 connected schools in Botswana. Bottom: 3
unconnected schools in Rwanda, 2 unconnected schools in Botswana.

Table 2: The class distribution (Yes = Connected to internet, No = Not connected to internet) across the training,
validation and test sets of Botswana (BWA) and Rwanda (RWA).

Training (70%) Validation (15%) Test (15%)
Yes No Yes No Yes No

BWA 327 307 74 62 75 62

RWA 1317 1025 295 207 276 235

[UNICEF, 2023b]. Project Connect aims to map real-time school connectivity and provide this critical informa-
tion to governments and internet service providers (ISPs) globally. Table 2 summarizes the class balance of con-
nected/unconnected schools in our study countries Botswana and Rwanda. Figure 1 shows 6 visual examples of
connected (top row) and unconnected (bottom row) schools.

3.2 Satellite Imagery to Feature Embeddings

Problem Formulation: School Connectivity Prediction: We model connectivity prediction as a binary classification
task, wherein we classify each sample (school) represented by a feature vector of engineered features, location encoder
model embeddings, or a combination based on its internet connectivity status. We have a dataset D which contains
(xi, yi)i where xi in X is a vector of features representing a combination of information extracted from satellite imagery
(e.g. land cover, nightlight), survey and ground-based measurements (e.g. Ookla Speedtest, global transmission line
network) and/or embeddings from location encoder models about a school I and yi in Y is the internet connectivity
status (i.e. 1 connected, 0 not connected) we aim to predict. Figure 2 depicts a overview of the methodological workflow
of feature generation and connectivity classification.

We explore the use of vector embeddings extracted from the location encoders of three pre-existing models as inputs
into our ML classifiers for connectivity prediction, namely SatCLIP, GeoCLIP and CSP [Klemmer et al., 2023, Vivanco
Cepeda et al., 2023, Mai et al., 2023], and our newly developed PhilEO Very High Resolution (VHR) Pre-cursor model
with embedding sizes of 256, 512, 256, and 1024, respectively. Vector embeddings extracted from images can be
thought of as extremely small summaries of those images which claim to capture the ground conditions including
population density, housing infrastructure, sun exposure, and more [Klemmer et al., 2023]. Each location encoder used
in our study is trained with a different dataset to explore performance differences between imagery sources. CSP was
selected for its pre-training on the Functional Map of the World (FMoW) datatset, which was developed to predict
the functional purpose of buildings and land use from satellite images and complementary metadata features [Christie
et al., 2017]. Categories in FMoW are grouped according to their purpose, and it is proposed that there is potential to
delineating connectivity status from buildings (in our case schools), by leveraging the embeddings from a pre-trained
model on this dataset. The CSP model is also available in its pre-trained form on the iNaturalist dataset [Van Horn
et al., 2017], however this was not pursued as the dataset is not appropriate for our use case. SatCLIP was selected
because of its superior performance to other location encoder techniques (including CSP) for the downstream tasks of
air temperature, median household income, elevation and population prediction shown in their work in [Klemmer et al.,
2023], which highlights the model’s ability to be utilized in diverse downstream tasks. We included GeoCLIP for its
performance achieved in their work in limited-data settings using the MediaEval Placing Tasks 2016 dataset [Larson
et al., 2017, Vivanco Cepeda et al., 2023]; in the context of our work, we have a relatively small dataset of schools.
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4 Methodology

Figure 2: Methodological workflow for connectivity prediction using engineered features and location encoder
embeddings. Top: Per latitude, longitude point representing a school location with known internet connectivity label,
generate feature embedding for the corresponding satellite image geo-referenced to the point, per location encoder.
Bottom: Per latitude, longitude point representing a school location with known internet connectivity label and a
user-specified buffer, extract the satellite imagery within the buffer boundaries and calculate summary statistics of the
geospatial information to create tabular features.

ML Classifiers: We leverage shallow ML classifier architectures including Random Forest (RF), Gradient Boosting
(GB), Support Vector Machines (SVM), Logistic Regression (LR), Extreme Gradient Boosting (XGB) and the Multi-
Layer Perception (MLP) neural network. We selected these models over more complex deep learning architecture due
to the small size of our dataset and the history of superiority of tree-based models on tabular data over deep learning
[Grinsztajn et al., 2022].

ESA PhilEO VHR: The ESA ϕ-lab PhilEO VHR Pre-cursor model is a deep learning architecture and semi-supervised
pre-training methodology for training large-scale geographical aware deep learning models [Fibaek et al., 2024]. The
setup consists of a U-Net with learned skip-connection, where each block is penalized for transferring information
of depending on spatial resolution of the connection. During training most of the skip connection are replaced with
Gaussian noise of the same mean and standard deviation as the original as well as masking. Besides autoencoder
features, the embedding space is used to attach a series of heads, which predict global features and coordinates of:
Sinusoidal Encoded Coordinates [Fibaek et al., 2024], Ground Sampling Distance, Climate Zones [Beck et al., 2018],
Land Cover [Zanaga et al., 2022], Water Presence [Melchiorri and Kemper, 2023], and Building Presence [Melchiorri
and Kemper, 2023]. A cosine-similarity based contrastive loss is applied on the embeddings versus embeddings of
augmented images of the same location [Wojke and Bewley, 2018]. Owing to the global and large-scale dataset, the
batch order can be flipped and the images used as negative sample pairs, although with less weight applied to negative
samples. The sampling of the model is 50,000 global locations with settled areas being over sampled at twice the
likelihood as other places, shown in Figure 3. Each city with at least 50,000 inhabitants is sampled at least once. Each
location is sampled multiple times at different spatial resolution.

Experimental Setup: We investigate four feature space setups for our prediction task:

• Hand-crafted EO engineered features: features derived from GEE, power grid, and speedtest data.

• Feature embeddings: vector outputs from location encoder models.

• Combined: combined engineered and PhilEO VHR Pre-cursor model embeddings.

• Engineered features + auxiliary school data: GEE, power grid, speedtest and ground-based survey data.
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Figure 3: PhilEO VHR sampling distribution

Table 3: Averaged test set F1 and Accuracy (Acc) using SatClip (S), GeoClip (Geo), CSP, features for Botswana (BWA)
and Rwanda (RWA).

S-R18-10 S-R18-40 S-R50-10 S-R50-40 S-V16-10 S-V16-40 Geo CSP
Acc F1 Acc F1 Acc F1 Acc F1 Acc F1 Acc F1 Acc F1 Acc F1

B
W

A

RF 0.56 0.49 0.56 0.53 0.58 0.54 0.58 0.55 0.56 0.47 0.57 0.54 0.63 0.68 0.58 0.53

MLP 0.50 0.40 0.51 0.38 0.48 0.28 0.50 0.34 0.49 0.32 0.50 0.39 0.55 0.55 0.52 0.54

GB 0.57 0.50 0.52 0.50 0.52 0.43 0.54 0.44 0.54 0.45 0.57 0.54 0.65 0.71 0.53 0.44

SVM 0.53 0.54 0.61 0.57 0.54 0.52 0.62 0.57 0.50 0.50 0.19 0.50 0.54 0.70 0.52 0.48

LR 0.52 0.68 0.54 0.45 0.51 0.40 0.55 0.58 0.52 0.15 0.47 0.27 0.61 0.67 0.51 0.59

XGB 0.60 0.54 0.62 0.59 0.53 0.45 0.60 0.59 0.53 0.41 0.53 0.40 0.63 0.69 0.55 0.52

R
W

A

RF 0.63 0.68 0.62 0.67 0.63 0.68 0.63 0.68 0.63 0.68 0.62 0.68 0.62 0.69 0.60 0.65

MLP 0.60 0.66 0.60 0.67 0.62 0.62 0.61 0.63 0.60 0.61 0.57 0.59 0.60 0.65 0.58 0.63

GB 0.63 0.70 0.62 0.67 0.65 0.71 0.63 0.68 0.65 0.71 0.62 0.68 0.63 0.69 0.59 0.66

SVM 0.64 0.71 0.54 0.70 0.54 0.70 0.54 0.70 0.59 0.69 0.54 0.70 0.64 0.71 0.61 0.72

LR 0.59 0.67 0.60 0.67 0.61 0.67 0.59 0.67 0.61 0.67 0.59 0.67 0.64 0.69 0.60 0.70

XGB 0.65 0.71 0.65 0.72 0.63 0.69 0.63 0.71 0.63 0.69 0.64 0.71 0.63 0.70 0.61 0.69

In all experiments, models are trained, validated and tested on a per-country level with a 70/15/15 train/validation/test
split. We implement grid search cross validation to exhaustively tune model hyperparameters, with details of our defined
search space included in our Supplementary Materials. Experimental setups one and two investigate model performance
leveraging engineered features and extracted features from location encoders as inputs individually. Experiment three is
designed to evaluate the hypothesis that the information learned from the location embeddings could be complementary
to the engineered features, thereby increasing the overall performance of the models for connectivity prediction over
using engineered or embeddings only. Experiment four investigates model performance when combining engineered
features with ground-based survey data.

5 Results and Discussion

Connectivity Prediction Model Performance: For both Botswana and Rwanda, models trained with the engineered
feature space out-perform the location-encoded feature spaces. In Botswana, the GB model trained with the PhilEO VHR
Pre-cursor and engineered features slightly out-performs all other configurations, which suggests that our hypothesis
that information learned from the location embeddings can be complementary to the engineered features, however
we do not see these same results in Rwanda, with further discussions on the limitations of our methodology below.
Tables 3-4 summarize the F1 score and accuracy per classifier architecture and feature space. Overall, though feature
embeddings have been claimed in the literature to sufficiently summarize complex socio-economic ground conditions
from satellite imagery, summary statistics and metrics extracted using domain expert insight in our engineered feature
space show greater performance, though not perfect, to our task of internet connectivity prediction. This is a particularly
important takeaway when considering low-resource settings. It is unreasonable to assume a developing nation will have
access to proprietary, high-resolution satellite imagery for infrastructure development; freely available data can act as a
sufficient starting point for these socio-economic applications.
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Table 4: Averaged test set F1 and Accuracy (Acc) using Engineer (Eng), PhilEO (Phi) location encoder and combined
features for Botswana (BWA) and Rwanda (RWA).

Eng Phi Phi+Eng
Acc F1 Acc F1 Acc F1

B
W

A

RF 0.68 0.71 0.58 0.53 0.61 0.71

MLP 0.63 0.66 0.52 0.54 0.64 0.69

GB 0.64 0.67 0.53 0.44 0.70 0.73
SVM 0.63 0.68 0.52 0.48 0.63 0.68

LR 0.63 0.67 0.51 0.59 0.55 0.58

XGB 0.64 0.67 0.55 0.52 0.63 0.68
R

W
A

RF 0.63 0.71 0.55 0.69 0.56 0.69

MLP 0.59 0.67 0.52 0.62 0.53 0.69

GB 0.61 0.70 0.53 0.63 0.56 0.63

SVM 0.62 0.72 0.55 0.70 0.56 0.70

LR 0.59 0.70 0.55 0.68 0.55 0.68

XGB 0.61 0.67 0.54 0.66 0.59 0.67

Feature Importance: Information from Global Human Settlement Layer (GHSL) strongly influenced the RF model’s
predictions and was present in four of the top ten features for Botswana and Rwanda. GHSL describes the inner
characteristics of human settlements in terms of the functional and height-related components of the built environment.
Intuitively, it is expected that the relative distance of a school to the power grid transmission line network would have a
direct correlation to its electricity connection and therefore its internet connectivity. We see this claim supported in
Rwanda in Figure 4 where the distance to transmission line network is ranked 5th of the top ten features. Nighttime
light features are also present in the top ten features for both countries. If we consider that internet connectivity
prediction is related to poverty prediction (i.e., poor regions are less likely to be connected than higher-income regions),
this result is consistent with the literature, whereby night-time light is used a proxy for poverty in numerous studies
with ML for poverty prediction [Noor et al., 2008, Xu et al., 2021, Jean et al., 2016].

Figure 4: Feature Importance. Left: Botswana Right: Rwanda

Case Study: Kigali, Rwanda:

To further investigate model performance, we take the case study of Kigali, Rwanda. We note that consistently, models
using engineered features and location encoder-generated features struggle to perform greater than 62% accuracy and
0.72 F1 score in the country, with the best performing models in terms of F1 score (SVM with engineered features)
having an average False Positive (FP) rate of 63%, True Positive (TP) rate of 87%, False Negative (FN) rate of 13%,
and True Negative (TN) rate of 36%. FPs are the most detrimental to real-world operationalization of our methodology,
because this means that we are incorrectly identifying a school as connected, and would thereby be incorrectly diverting
resources for improving digital infrastructure for these schools. To look further into why the FP rate is so high, we
explore the ground truth conditions in the capital city of Kigali. We plot the connectivity ground truth and RF model

7



Pre-print

Figure 5: South-West Kigali. Left: Ground-Truth labels, Right: Model Predictions.

predictions using the engineered feature space and highlight three locations in the South-Western part of the city
(latitude, longitude bounds of (30.02,-2.01), (30.11,-1.93) respectively) of noteworthy ground truth distribution, shown
in Figure 5. We highlight three regions, A, B, and C, which show schools very close in proximity (less than 400m) from
one another that have different connectivity status. In region A, the unconnected school is approximately 370m away
from the nearest connected school, region B, the unconnected school is approximately 165m away from the nearest
connected school, and for region C, the unconnected school is approximately 230m away from the nearest connected
school. Unsurprisingly, our models struggle in these three regions; when considering our engineered feature space, this
makes sense as we are taking data from a 1,000m radius with each school at the centre point, resulting in overlapping
information between neighbouring schools that could be construing our model from delineating its true connectivity
status.

Incorporating Auxiliary School Information: Across all model architectures and feature spaces, the models struggle
with connectivity prediction accuracy, particularly over Rwanda. We therefore investigated incorporating additional
auxiliary information about the schools in Experiment 4 using the UNICEF database, geoBoundaries2 regional indicators,
and Gridded Sex-Disaggregated School-Age Population [Bondarenko et al., 2022] into our feature space. From UNICEF,
we added school education level, school distance to nearest Long-Term Evolution station, distance to nearest Universal
Mobile Telecommunications System station, and distance to nearest Global System for Mobile communication station.
We add regional indicators by treating the administrative boundaries of the country as categories and employ one-hot
encoding on the categorical level-2 administrative zones of the country information to add as features. For edge-cases
where the schools were slightly outside of a country’s boundary (due to label noise), the administrative boundary that
was closest to the school was taken as school’s region. We incorporate the sum, mean, min, max, and variance of
primary and secondary school age male and female students within a 1,000m radius of each school, with further details
in Supplementary Materials. Results of our experiment are summarized in Table 5. The accuracy, F1 score and FP rate
all noticeably improve when incorporating auxiliary school information. FP rates drop from 48% to 19% in Botswana
and 64% to 26% in Rwanda, and accuracy scores reach 80% and 73% respectively.

6 Limitations and Future Directions

Globally Generalizable, Geographically-aware Models: Our results show that classifier performance using the
pre-trained location encoders as feature extractors is consistently limited across the four location encoder models.
This is likely due to the complexity of our use-case, and relatively low spatial resolution of the data used to train the
location encoders, and highlights the limitations of "globally-generalizable" location encoders for the downstream task
of internet connectivity prediction.
Label Quality: A distinct limitation of this work is the overall quality of the dataset and the validity of the ground truth
connectivity labels. As schools are connected by government partners, there is an undefined latency between connection
and updated record of the connection shared, which could mean that there are schools whose connectivity status does
not accurately represent its reality. To combat this, continued communication with country stakeholders is critical to

2
https://www.geoboundaries.org/countryDownloads.html
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Table 5: Averaged test set F1, FP and Accuracy (Acc) with auxiliary data for Botswana (BWA) and Rwanda (RWA)

BWA RWA
No Auxiliary Incl. Auxiliary No Auxiliary Incl. Auxiliary

F1 Acc FP F1 Acc FP F1 Acc FP F1 Acc FP
RF 0.71 0.68 0.40 0.77 0.73 0.39 0.72 0.63 0.65 0.73 0.65 0.62

MLP 0.66 0.63 0.44 0.77 0.74 0.29 0.67 0.59 0.59 0.69 0.66 0.38

GB 0.67 0.64 0.39 0.79 0.78 0.19 0.70 0.61 0.67 0.71 0.62 0.62

SVM 0.68 0.63 0.48 0.76 0.75 0.19 0.72 0.62 0.64 0.74 0.73 0.26
LR 0.67 0.63 0.44 0.76 0.69 0.53 0.70 0.59 0.72 0.74 0.71 0.34

XGB 0.67 0.64 0.40 0.81 0.80 0.13 0.67 0.61 0.54 0.74 0.68 0.48

maintain accurate, timely labels of school internet status.
Connectivity Quality: To maximize its impact on society, digital connectivity must be universal and meaningful,
allowing users to have a safe, satisfying, enriching and productive online experience at an affordable cost [ITU and
United Nations , 2022]. Our methodology can be improved in future work to not only to know the binary (yes/no)
connectivity status of a school, but to also estimate its connectivity quality, through leveraging information like that
available from Ookla Speedtest in addition to community partners who can monitor internet quality (i.e., download
and upload speeds) in-schools. In addition, it would provide greater value to country stakeholders to incorporate
a cluster-based analysis in our work, to include additional information about the socio-economic status of each
connected/unconnected school. Future work will include collaborating with government partners to ground-validate
model predictions.

7 Conclusion

Our work investigates Machine Learning for internet connectivity prediction in schools in Botswana and Rwanda,
providing a new, multi-modal geospatial dataset and feature generation pipeline openly-available to the community,
which can easily extend this study to other countries. We highlight the performance differences using hand-crafted
features compared to geographically-aware location encoders, and show that incorporating auxiliary school information
greatly improves predictive capabilities, achieving our highest accuracy, F1 scores of 80%, 0.81 in Botswana and 73%,
0.74 in Rwanda.
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A Technical Appendix

B Code and Data Availability

We provide the entire project code with the documentation needed to generate the feature space, train,
test and validate our models with links to the pre-processed and cleaned data to re-run experiments at:
https://github.com/kelsdoerksen/giga-connectivity

C School Connectivity Dataset Creation

Geospatial Data Preprocessing. To generate our geospatial features, we treat each school location (latitude, longitude
point) with connectivity information as the center point for which we extract geospatial data surrounding the area
of interest. To do so, we leverage the open-source datasets from Google Earth Engine (GEE), and specify a radius
extent ranging from 300m, 500m, 750m, 1000m and 5000m, respectively. Using the airPy3 data processing package,
we modified the package to include support for the Global Human Settlement Layer (GHSL) and Global Human
Modification (GHM) datasets, and extract GHSL, GHM, MODIS, VIIRS Nighttime Lights, and Gridded Population
of the World data for each point in the varying array size respectively. We then calculate summary statistics from the
image arrays including mode, mean, maximum, minimum, variance, and percent of land cover class where appropriate,
to create our tabular dataset of geospatial features per school. Table 6 summarizes the key information about the Google
Earth Engine datasets used in our study.

Table 6: Google Earth Engine Datasets Used for Feature Space
Dataset Resolution Period Classes
VIIRS Nighttime Day/Night

463.83m 2022
Average DNB radiance values

Band Composites V1 Cloud-free coverages

500m 2020

Evergreen Needleleaf Forests, Evergreen Broadleaf Forests, Deciduous Needleleaf Forests,

MODIS Land Cover LC_Type1 Deciduous Broadleaf Forests, Mixed Forests, Closed Shrublands

Yearly Global Open Shrublands, Woody Savannas, Savannas, Grasslands

Permanent Wetlands, Croplands, Urban and Built-up Lands,

Cropland/Natural Vegetation Mosaics, Permanent Snow and Ice, Barren, Water Bodies

Global Human Settlement Layer 10m 2018

open low vegetation surfaces, open medium vegetation surfaces, open high vegetation surfaces,

open water surfaces, open road surfaces, built residential - building height = 3m,

built residential - 3m building height = 6m, built residential - 6m building height = 15m,

built residential - 15m building height = 30m, built residential - building height 30m,

built residential - building height = 3m, built non-residential - 3m building height = 6m,

built non-residential - 6m building height = 15m, built non-residential - 15m building height = 30m,

built non-residential - building height 30m

Global Human Modification 1000m 2016 global Human Modification index

Population Density (Gridded
927.67m 2020 Estimated number of persons per square kilometer

Population of the World Version 4.11)

Buffer extent selection. We explore ML classifier performance across all model types for Botswana and Rwanda
for varying buffer sizes of 300m, 500m, 750m, 1000m, and 5000m. The purpose of this experiment is to determine
the optimal surrounding area to extract geospatial information for each school to create our feature space. Intuitively,
too small of an area surrounding a school may not capture important information about the geographic context that
could signal internet connectivity. For example, the Global Human Settlement Layer: Global settlement characteristics
dataset used in our work includes information about global settlement characteristics at a 10m resolution. This includes
classes such as open spaces and high vegetation surfaces which could indicate a school is in a rural area and perhaps
less likely to be connected to electricity or the internet, versus a school that is surrounded by built spaces including
residential and non-residential buildings of varying height, which could indicate more developed areas of the country
that could be more likely to have internet infrastructure. Conversely, too large of an area surrounding the school could
result in data leakage between neighbouring schools, which can result in model confusion and decrease in classification
performance. We showcase examples of buffer overlap in Figure 6, selecting two examples in the Molopolole and
Sikwane municipalities in Botswana, we can see the connected (triangle) and unconnected (circle) schools have a
overlap in their 5000m buffer extent, which could confuse our models. Table 7 and Figure 7 summarize the average

3
https:/github.com/kelsdoerksen/airPy
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Table 7: Test Set Results for varying Feature Space with Geospatial and Movement data
300m 500m 750m 1000m 5000m

Acc F1 Acc F1 Acc F1 Acc F1 Acc F1

B
W

A
RF 0.63 0.68 0.67 0.72 0.67 0.72 0.68 0.71 0.64 0.65

MLP 0.58 0.63 0.59 0.63 0.59 0.64 0.63 0.66 0.54 0.57

GB 0.66 0.7 0.62 0.68 0.62 0.65 0.64 0.67 0.60 0.56

SVM 0.60 0.64 0.62 0.65 0.65 0.67 0.63 0.68 0.53 0.55

LR 0.48 0.51 0.56 0.60 0.61 0.65 0.63 0.67 0.55 0.59

XGB 0.65 0.70 0.66 0.70 0.63 0.67 0.64 0.67 0.54 0.68

R
W

A

RF 0.64 0.70 0.64 0.70 0.63 0.71 0.62 0.72 0.65 0.71

MLP 0.58 0.64 0.56 0.61 0.59 0.69 0.59 0.67 0.58 0.63

GB 0.59 0.58 0.60 0.60 0.63 0.70 0.61 0.70 0.59 0.66

SVM 0.58 0.67 0.58 0.66 0.62 0.71 0.62 0.72 0.62 0.70

LR 0.59 0.61 0.61 0.68 0.63 0.69 0.59 0.70 0.69 0.62

XGB 0.61 0.65 0.62 0.66 0.59 0.71 0.61 0.67 0.60 0.71

test set F1 and accuracy scores over varying buffer sizes for all classifiers. We can see that there is almost always a
distinct decrease in model performance jumping from 1000m to 5000m buffer extent, with most models exhibiting
the peak of their performance with the geospatial feature set between the 750m and 1000m buffer size. From these
results, we select the 1000m buffer model’s results to highlight in the paper and iterate with additional experimentation
incorporating auxiliary school information.

Figure 6: Depiction of 300m, 500m, 750m, 1000m, and 5000m buffer extents surrounding connected (green) and
unconnected (red) schools in Botswana in the Sikwane (left) and Molopolole (right) municipalities.

Ookla Speedtest Data. Ookla provides freely available global fixed broadband and mobile (cellular) network perfor-
mance data of zoom level 16 web mercator tiles (approximately 610.8m x 610.8m at the equator). Download speed,
upload speed and latency data are collected via Speedtest by Ookla applications for Androis and iOS and averaged
for each tile, and measurements are filtered to results containing GPS-quality location accuracy. For each latitude,
longitude point representing a school, we find the nearest Ookla tile and use the speedtest features defined in Table 8 to
represent the relevant fixed and broadband network performance of devices used around that school point.
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Figure 7: Average Test Run Accuracy and F1-Score for varying ML classifier with varying buffer size in Rwanda
(RWA) (left) and Botswana (BWA) (right)

Table 8: Ookla SpeedTest Features
Feature Description
avg_d_kbps_mobile Average download speed of all mobile tests performed in the nearest tile (kilobits per second)
avg_u_kbps_mobile Average upload speed of all mobile tests performed in the nearest tile (kilobits per second)
avg_lat_ms_mobile Average latency of all mobile tests performed in the nearest tile (milliseconds)
tests_mobile Number of mobile tests taken in the nearest tile
devices_mobile Number of unique mobile devices in the nearest tile
ookla_distance_mobile Distance of the nearest tile to the school location
avg_d_kbps_fixed Average download speed of all fixed broadband tests performed in the nearest tile (kilobits per second)
avg_u_kbps_fixed Average upload speed of all fixed broadband tests performed in the nearest tile (kilobits per second)
avg_lat_ms_fixed Average latency of all fixed broadband tests performed in the nearest tile (milliseconds)
tests_fixed Number of fixed broadband tests taken in the nearest tile
devices_fixed Number of unique fixed broadband devices in the nearest tile
ookla_distance_fixed Distance of the nearest tile to the school location

Electricity Transmission and Distribution Lines. We use the derived map of global electricity transmission and
distribution lines from the results of the gridfinder model, produced by ESMAP 4 5 to calculate the distance of each
school to the nearest transmission line as a model feature. Gridfinder is an open-source tool that uses multiple filtering
algorithms to night-time light imagery to identify locations most likely to be producing light from electricity, to create a
globally consistent database of medium and lower voltage transmission lines Arderne et al. [2020]. The tool has shown
an accuracy of 75% across 14 validation set countries, 9 of which are in Sub-Saharan Africa. To calculate the distance
of each school to the nearest gridfinder transmission line, we use the geospatial software tool QGIS-LTR, and describe
our steps for recreation in Table 9.

Auxiliary Data: School-Age Population. We explore the use of the Gridded Sex-Disaggregated School-Age Population
(2020) dataset, which includes the sex disaggregated school age population for countries and Dependent territories
in Africa. Because our work is focused particularly on internet connectivity in schools, we add the male and female
primary and secondary school age population sum, mean, mininmum, maximum, and variance surrounding each school

4
https://zenodo.org/records/3266988/

5
https://github.com/carderne/gridfinder/tree/1.0.0
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Table 9: QGIS Data Processing Steps to Calculate School Distance to Nearest Transmission Line
Step Instruction QGIS-LTR Actions
1 Load World Bank Official Boundaries data Select countries Layer → Open Attribute Table → Select Country of Interest →

and subset for country of interest Export Selected Layer as New Layer

Load Derived map of global electricity Select Transmission Line Layer → Vector Overlay: Extract/clip by extent →
2 transmission and distribution lines gpkg Input layer: Transmission Line Layer, Extent: Country Layer

file and clip to AOI extent

3 Load csv of school information as new Layer → Add Layer → Add Delimited Text Layer
School Locations Layer

Select School Locations layer → Open Attribute Table → Toggle Editing →
4 Calculate distance of school points to New field (name: distance_to_transmission_line) → Open field calculator →

nearest transmission line Update existing field (distance_to_transmission_line) →
length(make_line (\$geometry,closest_point (overlay_nearest (’line’, \$geometry)[0],\$geometry)))

location within a 1000m buffer. To generate the features, we take each latitude, longitude point representing a school
and draw a 1000m radius buffer centered on the school. Using the zonal statistics functionality in QGIS-LTR, we
calculate the summary statistics listed above in each buffer zone and use these as additional auxiliry information to train
our models. The Gridded Sex-Disaggregated School-Age Population (2020) is freely available as .tiff files per country
via the GEE Community Catalog 6.

Data Cleaning. We focus primarily on schools after early childhood education, removing schools that contain the
keywords “preschool”, “nursery”, and “kindergarten”. Duplicate points (i.e. multiple points referring to the same school
building), are removed by creating 25m buffers around each school location and grouping points that shared overlapping
buffer zones into a single school. We identified schools with similar names by applying fuzzy string matching for pairs
of schools that are within a distance of 300 m of each other. Using the RapidFuzz library7, we deduplicated school
names by identifying strings that match with a normalized Levenshtein similarity of at least 85% based on the optimal
alignment of the two strings. Erroneous data points in uninhabited locations are removed by referencing open-source
settlement data including the Microsoft building footprints8 and GHSL 9 [Marcello et al., 2023] datasets, drawing a
150m buffer around each point and calculating the sum of the pixels within the buffer area. Schools are retained only if
locations where the pixel sum from the rasterized Microsoft building footprints and GHSL were both nonzero.

D Spatial Distribution of Samples

The spatial distribution of connected and unconnected schools in Botswana and Rwanda is shown in Figure 8. We can
see that in Botswana, the density of schools is far lower than exhibited in Rwanda.

E Location Encoders

Table 10: Location encoder characteristics
Name Dataset Embedding Size
SatCLIP Sentinel-2 256

GeoCLIP MediaEval Placing Tasks2016 512

CSP Functional Map of the World 256

PhilEO VHR VHR Collection 1024

To obtain the location embeddings for our school connectivity dataset from the pretrained models, we provide each
school latitude, longitude coordinate to the location encoders during the model.eval)() stage and extract the corresponding
embedding. Notebooks for the SatCLIP, GeoCLIP and CSP embedding generation are included in our shared git
repository.

6
https://gee-community-catalog.org/projects/wpschool/

7
https://github.com/rapidfuzz/RapidFuzz

8
https://github.com/microsoft/GlobalMLBuildingFootprints

9
https://ghsl.jrc.ec.europa.eu/download.php?ds=builtC
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(a) Botswana Connectivity Distribution (b) Rwanda Connectivity Distribution

Figure 8: Botswana (left) and Rwanda (right) spatial distribution of connected (green triangle) and unconnected (red
circle) schools in each country.

SatCLIP. The SatCLIP model uses the S2-100K dataset, which consists of 100,000 multi-spectral satellite images
sampled from Sentinel-2 via the Microsoft Planetary Computer 10. Images are sampled approximately uniformly over
landmass, and include only images without cloud overage. We use all six pre-trained SatCLIP models in our study,
trained with different vision encoders (ResNet, denoted by R, and Vision Transformer, denoted by V) and number
of Legendre polynomials used for spherical harmonics location encoding (denoted by L): SatCLIP-ResNet18-L10,
SatCLIP-ResNet18-L40, SatCLIP-ResNet50-L10, SatCLIP-ResNet50-L40, SatCLIP-ViT16-L10 and SatCLIP-ViT16-
L40.

GeoCLIP. GeoCLIP uses the MediaEval Placing Tasks 2016 (MP-16) dataset, which is composed of 4.7 million images
taken across the globe. The GeoCLIP model consists of two main components; a Location encoder L(.) that obtains
high-dimensional features from 2D GPS coordinates, and a CLIP-based image encoder V(.) to obtain the image features
Vivanco Cepeda et al. [2023]. GeoCLIP uses two contrastive learning strategies, SimCLR and CLIP [Chen et al., 2020,
Radford et al., 2021a]. The pretrained model from CLIP is used as the backbone for the GeoCLIP image encoder, and
the augmentation stratgey is similar to SimCLR, with the difference being that GeoCLIP matches an image to a gallery
of GPS features.

CSP. The Contrastive Spatial Pre-Training (CSP) model uses the Functional Map of the World (fMoW) dataset, designed
to inspire the devleopment of ML models capable of predicting the functional purpose of buildings and land use from
temporal sequences of satellite images. The dataset contains over one million images from over 200 countries.

F Model Configurations and Setup

Models are trained on a Intel(R) Core(TM) i9-10900K CPU /@ 3.70GHz Linux machine with 31 GB of available
memory. Each model leverages hyperparameter tuning through a 5-fold grid search cross-validation scheme via
scikit-learn on the validation set composed of 15% of total available samples per country, with search spaces defined in
Table 11 and best model configuration, selected by maximizing the combined F1 score and accuracy, show in Table 12.

G Additional Distributional Results

We run each model architecture, per country, per feature space, five times and report the average performance in all
tables in our main paper. We include the F1 and accuracy variance per experimental setup in Tables 13 - 18 for Botswana
and Tables 19 - 24 for Rwanda below.

10
https://planetarycomputer.microsoft.com/
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Table 11: School connectivity model parameter search spaces for Random Forest (RF) Support Vector Machines
(SVM), Logistic Regression (LR), Gradient Boosting Classifier (GB), Extreme Gradient Boosting Classifier (XGB)
and Multilayer Perceptron (MLP).

Model Parameters

RF

max depth: 80, 90, 100
max features: 2, 3, 4
min samples leaf : 3, 4, 5
min samples split: 4, 6, 8
n estimators: 100, 200, 300, 500

SVM

C: 0.001, 0.01, 0.1, 1.0, 10.0
kernel: linear, poly, rbf, sigmoid
degree: 1, 2, 3, 4
gamma: scale, auto

LR penalty: l2, None
C: 0.01, 0.1, 1.0

GB

loss: log loss, exponential
learning rate: 0.05, 0.1, 0.5, 1
n estimators: 100, 200, 300
criterion: freidman-mse, squared-error
min samples split: 2, 4, 6
min samples leaf : 1, 3, 5
max features: sqrt, log2, None

MLP

hidden layer sizes: (100,), (150,), (200,)
activation: logistic, tanh, relu
solver: lbfgs, sgd, adam
alpha: 0.0001, 0.005, 0.001
learning rate: constant, invscaling, adaptive

XGB

eta: 0.01, 0.05, 0.1, 0.15, 0.2
max depth: 3, 4, 5, 6
min child weight: 0, 1, 2
max delta step: 0, 1, 2
subsample: 0, 0.5, 0.75, 1
tree method: auto, exact, approx

Model Features Avg F1 F1 Variance Avg Accuracy Accuracy Variance
S-R18-10 0.49 0.0006 0.56 0.0002
S-R18-40 0.53 0.0006 0.56 0.0005
S-R50-10 0.54 0.0004 0.58 0.0001
S-R50-40 0.55 0.0019 0.58 0.0003
S-V16-10 0.47 0.0025 0.56 0.0007

RF S-V16-40 0.54 0.0008 0.57 0.0003
GeoCLIP 0.63 0.0003 0.6 0.0001
CSP 0.53 0.0007 0.58 0.0003
Eng 0.71 0.0002 0.68 0.0001
Phi 0.53 0.0005 0.58 0.0010
Phi + Eng 0.71 0.0002 0.61 0.0016

Table 13: Average F1 and Accuracy scores with variance over 5 runs for Random Forest Architecture for feature spaces
SatClip (S-), GeoCLIP, CSP, Engineer (Eng), Phi and Combined (Phi + Eng), Botswana
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Table 12: School connectivity model best parameter setting for Random Forest (RF) Support Vector Machines (SVM),
Logistic Regression (LR), Gradient Boosting Classifier (GB), Extreme Gradient Boosting Classifier (XGB) and
Multilayer Perceptron (MLP).

Model Parameters BWA RWA

RF

max depth 80 80
max features 2 4
min samples leaf 5 5
min samples split 4 4
n estimators 500 200

SVM

C 0.1 0.1
kernel linear poly
degree 1 3
gamma scale scale

LR
penalty l2 l2
C 0.1 0.1

GB

loss exponential exponential
learning rate 0.05 0.05
n estimators 100 300
criterion friedman_mse squared_error
min samples split 2 2
min samples leaf 5 3
max features log2 None

MLP

hidden layer sizes 200 200
activation tanh relu
solver sgd adam
alpha 0.0001 0.005
learning rate constant constant

XGB

eta 0.01 0.2
max depth 4 5
min child weight 1 0
max delta step 1 0
subsample 0.75 1
tree method exact exact
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Table 14: Average F1 and Accuracy scores with variance over 5 runs for MLP Architecture for feature spaces SatClip
(S-), GeoCLIP, CSP, Engineer (Eng), Phi and Combined (Phi + Eng), Botswana

Model Features Avg F1 F1 Variance Avg Accuracy Accuracy Variance
S-R18-10 0.40 0.0213 0.50 0.0007

S-R18-40 0.38 0.0069 0.51 0.0003

S-R50-10 0.28 0.0024 0.48 0.0000

S-R50-40 0.34 0.0077 0.50 0.0004

S-V16-10 0.32 0.0136 0.49 0.0006

MLP S-V16-40 0.39 0.0177 0.50 0.0013

GeoCLIP 0.55 0.0095 0.55 0.0040

CSP 0.54 0.0023 0.52 0.0012

Eng 0.66 0.0001 0.63 0.0002

Phi 0.54 0.0025 0.52 0.0005

Phi + Eng 0.69 0.0028 0.64 0.0007

Table 15: Average F1 and Accuracy scores with variance over 5 runs for GB Architecture for feature spaces SatClip
(S-), GeoCLIP, CSP, Engineer (Eng), Phi and Combined (Phi + Eng), Botswana

Model Features Avg F1 F1 Variance Avg Accuracy Accuracy Variance
S-R18-10 0.5 0.0012 0.57 0.0007
S-R18-40 0.5 0.0034 0.52 0.0013
S-R50-10 0.43 0.0064 0.52 0.0018
S-R50-40 0.44 0.0005 0.54 0.0003
S-V16-10 0.45 0.0005 0.54 0.0014

GB S-V16-40 0.54 0.0037 0.57 0.0000
GeoCLIP 0.59 0.0039 0.56 0.0047
CSP 0.44 0.0017 0.53 0.0007
Eng 0.67 0.0004 0.64 0.0004
Phi 0.44 0.0020 0.53 0.0003
Phi + Eng 0.73 0.0004 0.7 0.0014
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Table 16: Average F1 and Accuracy scores with variance over 5 runs for SVM Architecture for feature spaces SatClip
(S-), GeoCLIP, CSP, Engineer (Eng), Phi and Combined (Phi + Eng), Botswana

Model Features Avg F1 F1 Variance Avg Accuracy Accuracy Variance
S-R18-10 0.54 0.0000 0.53 0.0000
S-R18-40 0.57 0.0000 0.61 0.0000
S-R50-10 0.52 0.0003 0.54 0.0001
S-R50-40 0.57 0.0000 0.62 0.0000
S-V16-10 0.5 0.0000 0.5 0.0000

SVM S-V16-40 0.5 0.0000 0.19 0.0000
GeoCLIP 0.58 0.0002 0.57 0.0001
CSP 0.48 0.0000 0.52 0.0000
Eng 0.68 0.0002 0.63 0.0001
Phi 0.48 0.0000 0.52 0.0001
Phi + Eng 0.68 0.0001 0.63 0.0001

Table 17: Average F1 and Accuracy scores with variance over 5 runs for LR Architecture for feature spaces SatClip
(S-), GeoCLIP, CSP, Engineer (Eng), Phi and Combined (Phi + Eng), Botswana

Model Features Avg F1 F1 Variance Avg Accuracy Accuracy Variance
S-R18-10 0.68 0.0000 0.52 0.0000
S-R18-40 0.45 0.0000 0.54 0.0000
S-R50-10 0.51 0.0000 0.4 0.0000
S-R50-40 0.58 0.0000 0.55 0.0000
S-V16-10 0.15 0.0000 0.52 0.0000

LR S-V16-40 0.27 0.0000 0.47 0.0000
GeoCLIP 0.7 0.0000 0.6 0.0000
CSP 0.59 0.0000 0.51 0.0000
Eng 0.67 0.0000 0.63 0.0000
Phi 0.59 0.0000 0.51 0.0000
Phi + Eng 0.58 0.0000 0.55 0.0000
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Table 18: Average F1 and Accuracy scores with variance over 5 runs for XGB Architecture for feature spaces SatClip
(S-), GeoCLIP, CSP, Engineer (Eng), Phi and Combined (Phi + Eng), Botswana

Model Features Avg F1 F1 Variance Avg Accuracy Accuracy Variance
S-R18-10 0.54 0.0000 0.6 0.0000
S-R18-40 0.59 0.0000 0.62 0.0000
S-R50-10 0.45 0.0008 0.53 0.0005
S-R50-40 0.59 0.0002 0.6 0.0002
S-V16-10 0.41 0.0000 0.53 0.0000

XGB S-V16-40 0.4 0.0021 0.53 0.0005
GeoCLIP 0.63 0.0005 0.6 0.0011
CSP 0.52 0.0000 0.55 0.0000
Eng 0.67 0.0023 0.64 0.0014
Phi 0.52 0.0000 0.55 0.000
Phi + Eng 0.68 0.0008 0.63 0.0002

Table 19: Average F1 and Accuracy scores with variance over 5 runs for RF Architecture for feature spaces SatClip
(S-), GeoCLIP, CSP, Engineer (Eng), Phi and Combined (Phi + Eng), Rwanda

Model Features Avg F1 F1 Variance Avg Accuracy Accuracy Variance
S-R18-10 0.68 0.0001 0.63 0.0001
S-R18-40 0.67 0.0000 0.62 0.0000
S-R50-10 0.68 0.0001 0.63 0.0000
S-R50-40 0.68 0.0000 0.63 0.0000
S-V16-10 0.68 0.0002 0.63 0.0003

RF S-V16-40 0.68 0.0001 0.62 0.0001
GeoCLIP 0.69 0.0001 0.62 0.0001
CSP 0.65 0.0000 0.6 0.0000
Eng 0.71 0.0000 0.63 0.0001
Phi 0.69 0.0001 0.55 0.0003
Phi + Eng 0.69 0.0000 0.56 0.0000
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Table 20: Average F1 and Accuracy scores with variance over 5 runs for MLP Architecture for feature spaces SatClip
(S-), GeoCLIP, CSP, Engineer (Eng), Phi and Combined (Phi + Eng), Rwanda

Model Features Avg F1 F1 Variance Avg Accuracy Accuracy Variance
S-R18-10 0.66 0.0014 0.6 0.0004
S-R18-40 0.67 0.0007 0.6 0.0007
S-R50-10 0.62 0.0054 0.62 0.0020
S-R50-40 0.63 0.0052 0.61 0.0005
S-V16-10 0.61 0.0093 0.6 0.0008

MLP S-V16-40 0.59 0.0108 0.57 0.0018
GeoCLIP 0.65 0.0010 0.6 0.0010
CSP 0.63 0.0178 0.58 0.0018
Eng 0.67 0.0007 0.59 0.0010
Phi 0.62 0.0086 0.52 0.0003
Phi + Eng 0.69 0.0001 0.53 0.0001

Table 21: Average F1 and Accuracy scores with variance over 5 runs for GB Architecture for feature spaces SatClip
(S-), GeoCLIP, CSP, Engineer (Eng), Phi and Combined (Phi + Eng), Rwanda

Model Features Avg F1 F1 Variance Avg Accuracy Accuracy Variance
S-R18-10 0.7 0.0002 0.63 0.0001
S-R18-40 0.68 0.0018 0.62 0.0016
S-R50-10 0.71 0.0026 0.65 0.0020
S-R50-40 0.68 0.0011 0.63 0.0006
S-V16-10 0.71 0.0006 0.65 0.0006

GB S-V16-40 0.68 0.0029 0.62 0.0014
GeoCLIP 0.69 0.0001 0.63 0.0002
CSP 0.66 0.0017 0.59 0.0010
Eng 0.7 0.0001 0.61 0.0002
Phi 0.63 0.0007 0.53 0.0002
Phi + Eng 0.63 0.0011 0.56 0.0001
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Table 22: Average F1 and Accuracy scores with variance over 5 runs for SVM Architecture for feature spaces SatClip
(S-), GeoCLIP, CSP, Engineer (Eng), Phi and Combined (Phi + Eng), Rwanda

Model Features Avg F1 F1 Variance Avg Accuracy Accuracy Variance
S-R18-10 0.71 0.0000 0.64 0.0000
S-R18-40 0.7 0.0000 0.54 0.0000
S-R50-10 0.7 0.0000 0.54 0.0000
S-R50-40 0.7 0.0000 0.54 0.0000
S-V16-10 0.69 0.0000 0.59 0.0000

SVM S-V16-40 0.7 0.0000 0.54 0.0000
GeoCLIP 0.71 0.0000 0.64 0.0000
CSP 0.72 0.0000 0.61 0.0000
Eng 0.72 0.0000 0.62 0.0000
Phi 0.7 0.0000 0.55 0.0000
Phi + Eng 0.7 0.0000 0.56 0.0000

Table 23: Average F1 and Accuracy scores with variance over 5 runs for LR Architecture for feature spaces SatClip
(S-), GeoCLIP, CSP, Engineer (Eng), Phi and Combined (Phi + Eng), Rwanda

Model Features Avg F1 F1 Variance Avg Accuracy Accuracy Variance
S-R18-10 0.67 0.0000 0.59 0.0000
S-R18-40 0.67 0.0000 0.6 0.0000
S-R50-10 0.67 0.0000 0.61 0.0000
S-R50-40 0.67 0.0000 0.59 0.0000
S-V16-10 0.67 0.0000 0.61 0.0000

LR S-V16-40 0.67 0.0000 0.59 0.0000
GeoCLIP 0.69 0.0000 0.64 0.0000
CSP 0.7 0.0000 0.6 0.0000
Eng 0.7 0.0000 0.59 0.0000
Phi 0.68 0.0000 0.55 0.0000
Phi + Eng 0.68 0.0000 0.55 0.0000
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Table 24: Average F1 and Accuracy scores with variance over 5 runs for XGB Architecture for feature spaces SatClip
(S-), GeoCLIP, CSP, Engineer (Eng), Phi and Combined (Phi + Eng), Rwanda

Model Features Avg F1 F1 Variance Avg Accuracy Accuracy Variance
S-R18-10 0.71 0.0002 0.65 0.0002
S-R18-40 0.72 0.0000 0.65 0.0000
S-R50-10 0.69 0.0005 0.63 0.0003
S-R50-40 0.71 0.0008 0.63 0.0006
S-V16-10 0.69 0.0000 0.63 0.0000

XGB S-V16-40 0.71 0.0001 0.64 0.0002
GeoCLIP 0.7 0.0002 0.63 0.0003
CSP 0.69 0.0000 0.61 0.0000
Eng 0.67 0.0005 0.61 0.0006
Phi 0.66 0.0007 0.54 0.0002
Phi + Eng 0.67 0.0007 0.59 0.0002
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